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INFOS zu OFFICE 2007

Dieses Dokument enthalt div. Notizen zu Office 2007, erhebt aber keinen Anspruch auf Vollstan-
digkeit oder Korrektheit - Verwendung auf eigene Gefahr. Ggf. enthaltene Fehler od. Erganzungen
bitte an den Autor melden (siehe 0.g. Webseite unter "Kontakt").
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1. Neue Funktionen (Word)

e Dokument kann jetzt als "abgeschlossen” gekennzeichnet werden (Menu unter Schaltflache
"Office")

o stark erweiterter WordArt-Funktionsumfang (jetzt "SmartArt") - u.a. fir Diagramme,
Organigramme, Pfeile etc.

e neu: "Designs" + Designschriftarten "+Textkérper" und "+Uberschriften” (vgl. Format >
Zeichen)

e Word - neue Optionen bei der Suche:

"Prafix beachten”, "Suffix beachten”, "Interpunktionszeichen ignorieren”, "Leerzeichen
ignorieren”

e neues Addin zum Speichern einer Word-Datei etc. als PDF- bzw. XPS-Datei (= &hnliches
Format von Microsoft) verfiigbar (zuséatzlicher Download + Installation erforderlich)

¢ Neue Optionen bei der AutoKorrektur
(AAutoKorrektur von Mathematikfi; unter " AutoKor:
"Integrierte Formatvorlagen fur Uberschriften", "Tabellen", "Setzt den linken und
Erstzeileneinzug fur Tabstopps und die Ricktaste"; verschiedene Optionen unter
"AutoFormat")

o div. neue Formatierungsmaoglichkeiten:
Typ Formatierung Bedeutung
Zeichenformatierung Unterstreichungsfarbe
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Absatzformatierung Einzlige spiegeln (evtl. identisch mit 2003-Option Seite ein-
richten > Mehrere Seiten ?)
Absatzformatierung Textfeldoptionen (evtl. identisch mit 2003-Optionen bei
Textfeld-Formatierung?)
Grafikformatierung Diverse, z.B. 3D-
Drehung, 3D-Format,
etc.

Neue Funktionen (Excel)

erweiterte Sortier-Funktionalitat unter Excel (mehr als 3 Sortierkriterien u.a.)
erweiterte Funktionalitat bei AutoFiltern

Jetzt 16384 Spalten und 1048576 Zeilen in einem Tabellenblatt moglich (bis Excel 2003: 256
Spalten / 65535 Zeilen)

Jetzt theoretisch max. 32767 statt 1024 Zeichen pro Zelle mdglich; allerdings ist die
Bearbeitung der Zelle etc. dann extrem langsam!

Neu: Fulleffekt / Zellen mit Farbverlauf formatieren (Start > "Schriftart>>" > Ausfullen)

Neu: Erweiterte Filter-Moglichkeiten fiir Datums- und Zeitangaben (= im Excel-internen Datum-
Zeit-Format), z.B. zum Filtern nach einem bestimmten Monat, unabhangig von Tag oder
Uhrzeit:

E F G
PC ~ | DatT¢ ,l Datum-Uhrzeit X

il Mach Datum sortieren (aufsteigend)
4l Nach Datum sortieren (absteigend)
Nach Farbe sortieren 12

&  Filter léschen aus "Datum-Uhrzeit"

Datumsfilter >

V| =wpE A

neue Maoglichkeiten bei bedingter Formatierung, z.B. je gro3er der Wert einer Zelle, desto
dunkler die Hintergrundfarbe

Vorteil: "Riickgangig machen" funktioniert jetzt auch nach dem Speichern noch!
AutoVervollstandigen fur Funktionen u.a.

wesentlich bessere Erklarung von Funktionen, schon beim Schreiben des Funktionsnamens
(Quickinfo)

Neue Funktionen (Outlook)

Durchsuchen aller Mail-Ordner (Postfacher + PST-Dateien) gleichzeitig mdglich (bisher immer
nur 1 Postfach/PST-Datei mdgl.) - siehe Schaltflache "Alle E-Mail-Elemente" in der
Navigationsleiste

"Ubereinanderlegen” von 2 Kalendern jetzt moglich! (2 Kalender hinzufugen + dann
Rechtsklick "Uberlagert anzeigen") - anschlieRend werden die Kalender als 2 Register + die
Termin farblich unterschiedl. angezeigt:
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i TuK-Kalender in Offentliche Ordner - Microsoft Outlook

Datei Bearbeiten Ansicht Wechselnzu Extras Aktionen 2

i & X sb. - o B
A Neu v & ¥ g4 | Houte | [ Adressb. durchsuchen o @ -
Kalender <« Tag Woche Monat (8) arbeitswoche anzeigen () Volle Woche anzeigen
Januar 2007
€ (> =
VoM E s s 22 - 26. Januar 2007
= . luK-Kalender . Kalender
112 3456 7
s 910111213 14 22 Montag 23 Dienstag 24 Mittwoch 25  Donnerstag
315 16 17 18 19 20 21
S N T ]
|2 30 31
£ Alle Kalenderelemente -
Andere Kalender 2
[“] 7 1uK-Kalender in Offentliche Ordne ::ﬂ‘"‘s's‘“"'““g @
Meine Kalender = Fu: IT-Einfiihrung 1071
I Kalender 3} o

Vorschau auf Mail-Anlagen (Word-Dokument u.a.) mdglich, ohne diese 6ffnen zu mussen (inkl.
Sicherheitshinweis)

verwendet jetzt Windows Desktop Search 3.0 (+ entspr. Meldung, wenn diese nicht installiert
ist); Download + Installation von
http://www.microsoft.com/downloads/details.aspx?familyid=4982072F-7660-492F-B96C-
E42B4F5AB4AA&displaylang=de (siehe auch O:\Z5-Z6-
Intern\System\Fremd\Client\Windows\WinXPDesktopSearch3.0)

bei mehrtagigen Terminen wird im Kalender jetzt auch das Von-/Bis-Datum (hellgrau)
angezeigt:

2/ 1-5.Januar 2007 fadhd
1 Montag a2 Dienstag 3 Mittwoch 4 Donnerstag 5 Freitag

4 Von 14, Dez 06 GLO: Urlaub Bis 7. Jan »
4 \on 21, Dez 06 GUS: Urlaub 21.12.06 -05.01.07

Newsletter Personalborse = Junk E-Mail!?

Neu: Aufgabenbereich im rechten Teil mit Kalender + aktuellen Terminen (auch Termine der
nachsten Tage!)

beim 1. OL-Aufruf wird nach 3x "Weiter" alles automatisch konfiguriert (inkl. Postfach-
Einbindung; unter OL 2003 musste man noch den Servernamen + Benutzernamen eingeben!)

OL-Menus unverandert

VIS-Funktion "Speichern unter VIS" fehlt im Mail-Editor (evtl. ohnehin tGberflissig?)

Neu (?): Verschlisselung zw. OL und Exchange (siehe Kontoeinstellungen > Exchange > ...)
Unverandert KEINE Benachrichtigung bei neuen Mails in Zweit-Postfachern

beim ersten Zugriff auf einen Ordner in einer grolReren PST-Datei (290 MB) nach Outlook-Start
Wartezeit von ca. 15 Sek., danach schneller

Schliel3en eines Mail-Fensters jetzt nicht mehr mit Strg + F4 sondern Alt + F4

Hin- und Herwechseln (Vor/Zurtick) zw. versch. Ordnern jetzt wie im Browser mit Alt +
Links/Rechts moglich (evtl. auch unter OL 2003?)

(+) Auswahlfenster bei nicht eindeutigen Empfangernamen enthélt jetzt ALLE gefundenen
Kontakte aus ALLEN Adressbiichern (OL 2003: nur Kontakte aus dem "obersten"
konfigurierten Adressbuch, also entweder nur aus Kontakt-Ordner oder nur aus Globalem
Adressbuch, aber nicht beides)

U evtl. auch nur Zusammenhang mit Outlook-Konfiguration?

Termin-Erinnerungen funktioniert unverandert NICHT in Offentl. Ordnern (entspr. Meldung
beim Speichern) - evtl. auch weiterhin nur in Primarem Postfach (Standard-Postfach) des
Benutzers, nicht in zusétzlichen Postfachern, auf die der Benutzer Zugriff hat?

Mail direkt auf Kalendertag ziehen, um einen Termin zu erstellen

Neue Schaltflachen "Weiter" und "Zurtick" erleichtern das Navigieren innerhalb von zitierten
Mails (z.B. wenn Mails mehrmals mit "Antworten” oder "Weiterleiten" beantwortet wurden und
jedes Mal der vorherige Mailverkehr an die neue Mail angehéangt wird), z.B.:


http://www.microsoft.com/downloads/details.aspx?familyid=4982072F-7660-492F-B96C-E42B4F5AB4AA&displaylang=de
http://www.microsoft.com/downloads/details.aspx?familyid=4982072F-7660-492F-B96C-E42B4F5AB4AA&displaylang=de
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AW: Erfahrungen mit VIS V. 4.0

Gesendet: Montag, 8. Januar 2007 12:23

An: =
Cc:

Betreff: AW: Anfrage Betreff VIS 4

Hallo Frau Fischer,

Bei einfachem Kilick auf eine Mail-Anlage kann diese innerhalb des Mail-Fensters als Vorschau
angezeigt werden (Vorschau aber sehr durftig, z.T. sehr langsam, z.T. (Briefkopf mit Tabelle)
auch stark verzerrte/verschobene Darstellung)

Kopieren einer oder mehrerer Kontakte in der Listenansicht + Einfligen als Text (z.B. Word >
Bearbeiten > Inhalte einfligen > Unformatierter Text)

==> Kontakte werden in Tabellenform mit allen sichtbaren Spalten/Feldern eingefligt
(funktioniert auch unter 2003 schon)

beim Outlook-Start keine automatische Benachrichtigung mehr, dass der Abwesenheits-
Assistent aktiviert ist - stattdessen erscheint jetzt rechts unten in der Statusleiste der Text
"Abwesend"

Neue Funktionen (Outlook Mail-Editor)

die Option "Word als E-Mail-Editor verwenden" entfallt
==> eigener sehr Word-ahnlicher E-Mail-Editor, aber nicht 100% identisch

kein winword.exe-Task, z.T. bei Outlook-Fehlern/-Problemen aber trotzdem auch Beenden von
Word erforderlich!

Editor hat seine eigenen AutoKorrektur-Einstellungen; gemeinsame AutoKorrektur-Eintrage
(siehe Extras > Optionen > E-Mail-Format > Editor-Optionen)

viele Tastaturkirzel funktionieren wie unter Word (z.B. Strg+Shift+f fir Fettdruck); Aufruf von
Word 2003-Menufunktionen tber Alt-Taste aber NICHT!

Editor verwendet jetzt eine eigene "normal.dot”, die jetzt NormalEMail.dotm heif3t

benutzerspezifische Tastaturkiirzel, Formatvorlagen etc. aus Word stehen im Mail-Editor
NICHT zur Verfiigung (evtl. von Normal.dotm nach NormalEMail.dotm kopieren?)

Neue Funktionen (Office allgemein)

statt Menus und Symbolleisten jetzt neue Multifunktionsleiste (engl. "Ribbon™), in der die Icons
jetzt wie in Registern / Karteikarten angeordnet sind und véllig umstrukturiert wurden:

(" | O@i=-=-Bum8)- Dokument1 - Microsoft Word
]
/ Start EinfUgen Seitenlayout Verweise Sendungen Uberprufen Ansicht Entwicklertools Add-Ins
- v [ A% AT @y ] 32 . A= . e 22 E| (A
Arial 11 A N || =~ 4= - S| || 24|91 saBbca daBbCcL || AaBbCCL |-
F K v abe %, X' Aav|[¥2~ A-|||EEE = B||}=-(| O [~ Fett Hervorhe... | 1 Standard | -
: 4 v =

Zwischenablage ™ Schriftart " Absatz ‘ Formatvorlagen

o
l[._]j‘H‘\ 1 151502 | } o | v4 v o8 (SR ] K] IR R TR R I 14+ 1 415

~

(siehé auch Kapitel "Eingabehilfen / Bedienung")
Nachteil: es geht Platz am Bildschirm verloren, der 3-4 Symbolleisten entspricht
Abhilfe: Doppelklick auf eine bereits getffnete Registerkarte ==> Ribbon wird ausgeblendet,
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beim Anklicken eines Karteikartenreiters erscheinen auch die dazugehérigen Symbole (tempo-
rar) wieder

Dokumente in der Dateiliste im Office-MenU lassen sich jetzt "fixieren"”, so dass die Datei nie
aus der Liste entfernt wird (aber ggf. nach unten wandert)

bei Formatierungen tUber Multifunktionsleiste "Live-Vorschau" im Textfenster im Hintergrund

Seitenansicht enthalt jetzt nur die auch tatsachlich zum Drucken ausgewahlten Seiten (z.B.
Folie 1-4 unter Powerpoint)

neue Default-Schriftarten:

Anwendung Schriftart / Gré3e
Word, Excel, u.a. Calibri
Outlook / Text-Mail Consolas 10,5 pt
Outlook / RTF-Mail Calibri (Textkérper)
Outlook / HTML-Mail | Calibri (Textkdorper)
--> Nachteil: v.a. Mails sind auf (Windows-) PCs ohne diese Schriftart sehr schlecht lesbar
(lasst sich ggf. in der Datei NormalEMail.dotm andern)

Office-Installation enthéalt jetzt auch den Visio Viewer sowie div. neue TrueType-Schriftarten
(.TTF)

alle Funktionen zu Addins (Globale Vorlagen, COM-AddIns, Deaktivierte Elemente, etc.) jetzt
Ubersichtlich an einer Stelle tber Office-Schaltflache > Word-Optionen > Addins erreichbar

??? "Datei in bestimmten Abstanden herunterladen, mit der Systemprobleme bestimmt werden
kénnen" (Dialogfenster "Datenschutzoptionen" erscheint beim 1. Word-Aufruf)

Geanderte Funktionen/Arbeitsweise (Word)

Word: Div. Anderungen bei Formatvorlagen
("Schnellformatvorlagen”, die im Ribbon angezeigt werden / neue Dialogfenster / neue
Funktionen+Optionen etc.,)

Word: Div. Anderungen bei AutoTexten / "Bausteinen” (engl. "Building Blocks")

(neue Optionen, Bausteinkataloge, neue Dialogfenster, einfachere Erstellung von AutoText-
Kategorien); Datei "%appdata%\Microsoft\Document Building Blocks\1031\Building Blocks.dotx
" = zentrale Vorlage mit Bausteinen (wird vermutlich aus "C:\Programme\Microsoft
Office\Officel2\Document Parts\1031\Building Blocks.dotx" neu generiert, falls nicht
vorhanden)

Word: beim Offnen eines Word-Dokuments, das bereits (z.B. im Hintergrund) geoffnet ist,
erscheint jetzt nicht mehr die Riuckfrage "Wiederherstellen J/N?" sondern es wird einfach in das
entsprechende Fenster mit dem gedéffneten (+ ggf. bereits gednderten) Dokument gewechselt
(evtl. Anderung bereits unter Office 2003?)

exaktes Zuschneiden von Grafiken war bisher nur i.V.m. Alt-Taste mdglich - jetzt ohne Alt-
Taste (==> Funktionalitdt mit/ohne Alt-Taste jetzt genau umgekehrt)

Speichern einer Outlook-Suche als .0SS-Datei funktioniert nicht mehr (Dateityp unbekannt;
Menufunktion "Speichern unter" grau unterlegt)

Mischbetrieb Office 2003 / Office 2007

(= einige PCs / Benutzer arbeiten mit Office 2003, andere mit Office 2007, wobei auch Dateien
ausgetauscht werden)
(durfte analog auch fir Excel, Powerpoint, usw. gelten)

Falls mit Word 2007 erstellte Dateien auch unter Word 2003 bearbeitet werden sollen, muss
unter Word 2007 als Standard-Speicherformat "Word 2003" eingestellt werden. Dies flhrt
allerdings zu Einschrankungen - siehe Kapitel "Kompatibilitdtsmodus unter Word 2007".
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Falls mit Word 2007 erstellte Dateien unter Word 2003 nur gelesen werden sollen, kann
stattdessen auch auf dem PC mit Word 2003 der (kostenlose) Microsoft Viewer fur Word 2007
installiert werden. (Ob dieser allerdings alle Features aus Office 2007 100%ig korrekt
darstellen kann, ist unklar.)

Parallelinstallation Office 2003 / Office 2007

(= bei Office 2007-Installation wird lediglich Outlook 2003 entfernt, bei allen anderen Office-
Anwendungen bleibt die 2003-Version erhalten und die 2007-Version wird zusatzlich installiert)
(durfte analog auch fur Excel, Powerpoint, usw. gelten)

9.

Wird beim Word-Aufruf eine andere Word-Version aufgerufen als beim vorherigen Mal, wird
automatisch das Office-Setup gestartet und einige Konfigurationen / Registry-Keys geandert
bzw. auf die jeweilige Word-Version umgestellt (z.B. Verkniipfung div. Dateierweiterungen wie
.doc, .rtf etc. mit Word) - was z.T. etwas Geduld kostet.

U.U. lasst sich nach Office 2007-Installation im Hilfefenster kein Suchtext eingeben
(Eingabefeld deaktiviert) - dies lasst sich durch Léschen der Datei C:\Dokumente und
Einstellungen\<Benutzername>\Anwendungsdaten\Microsoft\CLView\Toolbars.dat beheben
(Datei wird automatisch neu angelegt).

Kompatibilitditsmodus unter Word 2007

(durfte analog auch fir Excel, Powerpoint, usw. gelten)

Wird unter Word 2007 als Standard-Speicherformat "Word 2003" verwendet oder ein einzelnes
Dokument in diesem Format geéffnet / gespeichert, schaltet Word automatisch in den "Kompatibili-
tatsmodus" gelten einige Besonderheiten:

Das Wort "Kompatibilititsmodus" wird in der Titelleiste am oberen Bildschirmrand angezeigt
(und nur dann ist dieser Modus auch aktiv!)

Funktionen und Formatierungen, die mit Word 2007 neu eingefiihrt wurden (siehe unten),
stehen nicht zur Verfiigung oder werden beim Speichern (nach entsprechender Warnung)
wieder entfernt.

Als Dateierweiterung wird wie unter Word 2003 ublich ".doc" verwendet (statt ".docx" unter
Word 2007).

Z.T. zeigt Word sogar vollig andere Meniis/Kontextmenis oder Dialogfenster an - z.B. bei
Rechtsklick auf eine Grafik:

Grafik formatieren

Farben und Linien | Gréfe Layout Alcernativiest
Zuschneiden von

Links: 0,3cm Chen: 0,2 cm

4[4

Rechts: 0,4 cm Unten: 0,4 cm
Bildsteuerung
Earbe: Automatisch A

Helligheit: € 3 |50

k(|4

Kontrast: < | |50%

Komprimieren. .. Zurlicksetzen

l Ok l [ Abbrechen ]
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(= aus Word 2003 bekanntes Dialogfenster)

Im "Normalmodus" (Word 2007-Format):

Fiillung Bild
Linienfarbe Meu einfarben:
Linienart
Heligkeit: J 0% 4
Schatten
Kontrast: J 0% £
3DFormat
30-Drehung Grafik zurlicksetzen
Bild
Textfeld

| Schiiefen |

10.Admin-Infos

¢ Neue Dateiformate unter Word, Excel, PowerPoint und Access 2007; It. MS erhohte Sicherheit
fur Dateien, geringere Wahrscheinlichkeit fir Dateibeschadigungen; auf3erdem It. Test z.T.
stark verringerte Dateigrof3e (z.B. Excel-Datei mit Eventlog-Daten: vorher 11 MB, nach
Speichern im neuen Format nur noch 3 MB)

¢ Neues Dateiformat basiert auf "Office Open XML-Format" (nicht identisch mit dem Dateiformat
von Open Office!); It. MS auch unter Office 2003 lesbar - beim Aufruf erscheint autom. eine
Ruckfrage zum Herunterladen eines Konverters (vermutlich aber nur mit lokalen Admin-
Rechten mdglich)

e in Access jetzt ACCDB-Format (statt bisher MDB) verwendet

e neue Dateierweiterungen:
.docx = Dokument ohne Makros
.docm = Dokument mit Makros
.dotx = Dokumentvorlage Makros
.dotm = Dokumentvorlage mit Makros
xml = Word XML-Dokument (s.u.)

e weiterhin unterstitzt:
.doc = Word 97-2003-Dokument
.dot = Word 97-2003-Dokumentvorlage
xml = Word 2003-XML-Dokument

e jetzt "normal.dotm" statt "normal.dot”, daher gleichzeitig Arbeit mit Word 2003 + 2007 mdglich
(z.B. 2 PCs mit gleicher AD-Kennung)

e Dbei 1. Aufruf wird die alte "normal.dot” in "normalll.dot" umbenannt!?
e eigene Datei "NormalEmail.dotm" fir Mail-Editor

¢ ggf. vorhandene normal.dot (2.200 KB) wird kopiert und in neuem Format unter normal.dotm
(380 KB!) gespeichert (automatisch konvertiert)
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Default: "Alle Makros mit Benachrichtigung deaktivieren" (gilt NICHT fir Makros in
vertrauenswirdigen Speicherorten!)
==> Sicherheitswarnung "Makros wurden deaktiviert" unterhalb der Symbolleisten; neue
Moglichkeit, trotzdem die Makros in dieser einen Datei zu aktivieren (==> Dok. wird auto-
matisch geschlossen + neu gedéffnet)

Default unter Word: 3 vertrauenswirdige Speicherorte (aber NICHT die eingestellten
AutoStart-Verzeichnisse):
C:\Programme\Microsoft Office\Templates
C:\Dokumente und Einstellungen\<Benutzername>\Anwendungsdaten\Microsoft\Vorlagen
C:\Dokumente und Einstellungen\<Benutzername>\Anwendungsdaten\Microsoftt\ Word\STARTUP

Default:Option "Vertrauenswirdige Speicherorte im Netzwerk zulassen” ist deaktiviert

11.Sinnvolle Voreinstellungen fir Admins/PowerUser (Word)

Option " Entwicklerregisterkarte in der Multifunktionsleiste anzeigen" aktivieren - wird z.B. zur
Makro-Programmierung benétigt (Word-Optionen > Haufig verwendet)

unter "Ausschneiden und Einfiigen mit Leerzeichenausgleich” > Einstellungen die Option
"Satz- und Wortabstand automatisch anpassen” deaktivieren (unter Word-Optionen >
Erweitert)

Option "Dateiformatkonvertierung beim Offnen bestatigen" aktivieren (Erweitert > Allgemein)
Option "Formatierung mitverfolgen" deaktivieren (Erweitert > Bearbeitungsoptionen)
Option "Aufforderung zur Vorlagenaktualisierung" aktivieren (Erweitert > Bearbeitungsoptionen)

Uberpriifen > Sprechblasen > Alle Ub_erarbeitungen inline anzeigen (ansonsten werden am
rechten Rand Sprechblasen mit den Anderungen angezeigt, die dann das ganze Layout des
Dokuments verandern (kleinere Schrift usw.)

Option "Vertrauenswirdige Speicherorte im Netzwerk zulassen" aktivieren (Erweitert >
Vertrauensstellungscenter > Einstellungen fir das Vertrauensstellungscenter >
Vertrauenswurdige Speicherorte)

(= Makros in Dateien, die Uber UNC-Pfad aufgerufen werden, z.B. \\server\freigabe)

Evtl. auch noch folgende Optionen:

evtl. Erweitert > Einfligen zwischen Dokumenten, wenn Formatvorlagendefinitionen nicht
Ubereinstimmen > Option "Urspriingliche Formatierung beibehalten" aktivieren (Default =
"Formatvorlagen des Ziels verwenden")

Option "E-Mail-Anlagen im Vollbild-Lesemodus 6ffnen” deaktivieren (Word-Optionen > Haufig
verwendet) - ansonsten werden (Word-) Anlagen ggf. stark verfalscht angezeigt

Speicherformat: "Word 97-2003" (Word-Optionen > Speichern)

Option, um Felder IMMER grau unterlegt anzuzeigen:
Word-Optionen > Erweitert > Dokumentinhalt anzeigen / Feldfunktionen anstelle von Werten
anzeigen: "Immer"

Option "Allgemeine Verkniipfungen beim Offnen aktualisieren" deaktivieren (Erweitert >

Allgemein)

- ansonsten erscheint beim Offnen eines Dokuments z.T. die Riickfrage "Das Dokument enthélt Verkniipfungen, die
maoglicherweise auf andere Dateien verweisen. Mchten Sie das Dokument mit den Daten aus den verknupften Dateien
aktualisieren?"

evtl. div. Pfade einstellen z.B. AutoStart-Pfad auf ein gemeinsam genutztes Server-Verzeichnis
(Erweitert > Allgemein > Dateispeicherorte) (Default: ??7?)

evtl. Pfad fir Worterblcher auf ein Benutzerverzeichnis auf dem Server etc. andern (Erweitert
> Allgemein > Dateispeicherorte) (Default: C:\Programme\...!)
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evtl. Makro-Sicherheitseinstellung &ndern? (Erweitert > Vertrauensstellungscenter >
Einstellungen fur das Vertrauensstellungscenter > Einstellungen fiir Makros)

evtl. Option "Fehler in Benutzeroberflachen in Addins anzeigen" aktivieren (Erweitert >
Allgemein)

ggf. Pfade hinzuflgen, auf denen die Ausfihrung von Makros (ohne Riickfrage) erlaubt werden
soll (Erweitert > Vertrauensstellungscenter > Einstellungen fur das Vertrauensstellungscenter >
Vertrauenswirdige Speicherorte):

12.Sinnvolle Voreinstellungen fir Admins/PowerUser (Excel)

Pfad fur AutoWiederherstellen-Dateien andern (wg. Roaming Profiles):

Optionen > Speichern > Dateispeicherort fur AutoWiederherstellen > Pfad auf %temp% andern
(normalerweise = %userprofile%\Lokale Einstellungen\Temp) (Default: %userprofi-
le%\Anwendungsdaten\Microsoft\Excel)

Option "Vertrauenswirdige Speicherorte im Netzwerk zulassen" aktivieren (Erweitert >
Vertrauensstellungscenter > Einstellungen fir das Vertrauensstellungscenter >
Vertrauenswirdige Speicherorte)

(= Makros in Dateien, die Uber UNC-Pfad aufgerufen werden, z.B. \\server\freigabe)

ggf. im Verzeichnis

%userprofile%\Anwendungsdaten\Microsoft\Exce\XLStart
Verknipfungen zu Excel-Dateien anlegen, die Makros enthalten, und die beim Excel-Start au-
tomatisch mitgeladen werden sollen

ggf. Option "Beim Start alle Dateien 6ffnen in" einstellen (Erweitert > Allgemein):

(beliebiges Verzeichnis)
(Hierdurch wird dieses Verzeichnis auch gleichzeitig automatisch unter "Richtlinienspeicheror-
te" als "Vertrauenswiirdiger Speicherort" (siehe unten) eingetragen, so dass dies nicht mehr
manuell geschehen muss)

ggf. Pfade hinzufigen, auf denen die Ausfiihrung von Makros (ohne Riickfrage) erlaubt werden
soll (Erweitert > Vertrauensstellungscenter > Einstellungen fir das Vertrauensstellungscenter >
Vertrauenswirdige Speicherorte):

13.Sinnvolle Voreinstellungen fiir Admins/PowerUser (Outlook/E-Mail-Editor)

Default-Schriftart fur Mails auf Arial 10 pt. andern, da "Calibri" auf PCs ohne diese Schriftart
sehr schlecht lesbar ist (Extras > Optionen > E-Mail-Format > Briefpapier und Schriftarten)

Option " Element als gelesen markieren, wenn neue Auswahl erfolgt" deaktivieren
(Extras > Optionen > Weitere > Lesebereich)

Option "Nach dem Verschieben oder Léschen eines gedffneten Elements ..." auf "Nachstes
Element 6ffnen” einstellen (Extras > Optionen > Einstellungen > E-Mail-Optionen >
Nachrichtenbehandlung)

Kontakte als "Nachname, Vorname" anzeigen (Extras > E-Mail-Konten > Vorhandene )
Verzeichnisse oder Adressbiicher anzeigen oder bearbeiten > Outlook-Adressbuch > Andern >
Namen ordnen: "Wie 'Speichern unter' (Mander, Jens)")

Option, um Felder IMMER grau unterlegt anzuzeigen:
Erweitert > Dokumentinhalt anzeigen / Feldschattierung: "Immer”

evtl. Protokollierung abschalten (Extras > Optionen > Weitere > Erweiterte Optionen > Option
"Protokollierung aktivieren™)
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14.Bereits erledigte Probleme / Fragen

Word: Formatierungen des markierten Absatzes in Formatvorlage tibernehmen? (Word 2003:
Strg + Shift + s usw.)

--> funktioniert nur, wenn die entspr. Option "Aufforderung zur Vorlagenaktualisierung" aktiviert
ist (Optionen > Erweitert > Bearbeitungsoptionen)

Outlook: Wie lasst sich ein Kalender aus den Offentlichen Ordnern unter "Meine Kalender"
hinzufiigen?

unter Outlook 2003: Wechseln zu > Ordnerliste > (betr. Ordner 6ffnen) > Kontextmenufunktion
"Zu Andere Kalender hinzufligen" - diese Funktion fehlt aber unter Outlook 2007; die Funktion
"Zu Favoriten hinzufiigen" erzeugt dagegen nur eine Verknupfung (Menu Wechseln zu >
Verknupfungen). Uber die Funktion "Freigegebenen Kalender 6ffnen" lassen sich dagegen nur
Kalender anderer Benutzer 6ffnen, Offentl. Ordner werden im entspr. Dialogfeld NICHT
angezeigt)

--> Drag&Drop von Ordnerliste (Strg+6) in freien Bereich in Kalender-Ansicht (Strg+2) (z.B.
links neben Eingabefenster fir Schnellsuche)

(evtl. anschlieBend Outlook-Neustart erforderlich?)

Word: Div. Pfade mit Netz-Laufwerksbuchstaben werden in den Word-Optionen automatisch in
UNC-Pfade aufgeltst (wie Word 97) - Abhilfe: Pfade direkt in die Registry schreiben (REG-
Datei)

in Absatz unterhalb einer nummerierten Uberschrift (FV) Symbol "Nummerierung starten”
anklicken )

==> wird autom. als Uberschrift formatiert!? (iber Dropdown-Pfeil neben dem Symbol geht's
aber)

Excel: Fehlermeldung bei SVERWEIS in Excel 2003-Format (.xIs):

"Ungiltiger Bezug. Diese Dateiversion darf keine Formeln enthalten, die auf Zellen verweisen,
die au3erhalb der Arbeitsblattgré3e von 256 Spalten (Spalte IW oder hdher) oder 65536 Zeilen
liegen."

Nach SchlieRen + Neu-Offnen der Arbeitsmappe, auf die sich die Formel bezieht, i.0. AuRer-
dem wird nach dem erneuten Offnen in der Titelleiste "Kompatibilitatsmodus" angezeigt, was
vorher nicht der Fall war. (Vorher war eine Textdatei Uber " Speichern unter" im Excel 97-2003-
Format gespeichert worden.)

Gleiche Fehlermeldung erscheint offensichtlich IMMER, wenn eine Arbeitsmappe im Excel 97-
2003-Format eine Bezug auf Zellen enthalt, deren Zeilen-/Spaltennummer in Excel 97-2003
nicht zuléassig war (d.h. Zeilen > 32767 oder Spalten > 256; in 0.g. Formel/Screenshot indirekt
durch den Bezug auf "$A:$F").

Sonstiges / Online-Hilfe: Eingabe eines Suchbegriffs im daftir vorgesehenen Feld nicht
moglich!?

--> vermutl. wg. Parallelinstallation Office 2003 / 2007; lasst sich durch Léschen der Datei
toolbars.dat (s.0.) beheben
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15.Probleme / Fragen / noch testen

e Outlook: Offentlichen Ordner aus der Liste "Meine Kalender" wieder entfernen?
--> evtl. Uber Kontextmenu "xxx l6schen"??? oder wird dann der Kalender selbst komplett
geldscht!?

¢ Word: Ruckfrage beim Speichern eines passwortgeschutzten/verschlisselten Dokuments "In

Office XML-Format konvertieren?"
Dieses Dokument ist sowohl verschlisselt als auch kennwortgeschutzt. Die Office Open XML-Formate, die in
Version 2007 verfugbar sind, bieten eine bessere Verschlisselung. Méchten Sie die Sicherheit dieses Doku-
ments erhéhen, indem es in ein Office Open XML-Format konvertiert wird? (Ja/Nein)

Bei "Ja" (= Default!) oder Enter-Taste wird das Dokument als Open XML-Datei gespeichert und
ist damit unter Word 2003 u.a. nicht mehr lesbar.
(Evtl. weitere Auswirkungen?)

e Word: Schriftarten "+Textkorper" bzw. "+Uberschriften” = 2?2

e Word: SQL-Rickfrage (z.B. bei Seriendruck-Hauptdokument) erscheint unter Word 2007,
obwohl diese Uber Group Policy / Registry-Key abgeschaltet wurde!? (vermutlich eigener
RegKey fur 2007?)

e Excel: wie lasst sich das AddIn "Euro-Wahrungstool" deaktivieren?
e Outlook: Besprechung Idschen ohne Absage zu senden nicht mehr moglich!? (unter 2003 i.0.)

e Outlook: Kalender wie unter 2003 in 2x3-Matrix (2 Spalten/3 Zeilen) darstellen? (==> Termine
besser lesbar)

e Outlook: nach Update stehen unter Outlook (+ im Mail-Editor) keine Makros mehr zur
Verfugung!? (evtl. aber nur wg. Anlegen eines neuen Profils?)

e Outlook: Absturz bei Mail-Versand eines Word-Dokuments mit VIS-Links (Standardbrief.doc);
Versand eines anderen Word-Dokuments ohne VIS-Links dagegen ohne Probleme

e Mail-Editor: beim Offnen und anschlieRenden SchlieBen einer Word-Mailanlage erscheint
regelmafig die Meldung "Wurde geandert - Speichern (J/N)?" (z.T. auch bei PDF!?)

e Mail-Editor: wie lasst sich hier die Silbentrennung aktivieren?

16.Fehler / Bugs

¢ Word: Suche nach Schriftfarbe "Grun" (RGB 0/128/0) in Word-Tabelle funktioniert einwandfrei
(auch mehrmals "Weitersuchen"); Funktion "Suche wiederholen" (Shift+F4) findet nur den
ersten Treffer, keine weiteren

e Excel: Start > Einfigen & > Inhalte einfiigen > Spaltenbreite > OK
==> pereits vorhandene Zellinhalte werden geldscht!

e Outlook: beim Kopieren eines Serientermins von einem Kalender in einen anderen (Strg +
Drag&Drop auf Kalendernamen links im Navigationsbereich) geht die Serien-Eigenschaft
verloren, d.h. der neue erzeugte Termin wird nicht regelmafig (z.B. wochentlich) wiederholt

e Outlook: Schaltflache "Anzeigen aus" musste eigentlich "Feld 'Von' anzeigen" hei3en

e Outlook: Blattern von einer getffneten Mail zur n&chsten mit Strg + "h" (It. QuickInfo)
funktioniert nicht mehr (entspr. Schaltflachen kdnnen aber tiber Schnellzugriff-Symbolleiste
verfugbar gemacht werden; Zurickblattern mit Alt + "h" funktioniert dagegen)

e Word: Im Dialogfeld "Tastatur anpassen” wird bei Tastaturkirzeln, die noch unter Word 2003
erzeugt wurden (automatische Konvertierung von normat.dot in normalm.dot), und die einem
Makro zugewiesen sind, bei "Derzeit zugewiesen an" KEINE Zuweisung angezeigt. Die
Tastaturkiirzel selbst funktionieren aber auch unter Word 2007 noch problemlos.

Wird ein Tastaturkirzel unter Word 2007 erstmalig oder (nach Entfernen) erneut vergeben, tritt
dieser Fehler nicht auf.
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¢ Silbentrennung funktioniert gelegentlich nicht korrekt - z.T. wird Gberhaupt nicht getrennt, z.T.
an der falschen Stelle (obwohl Sprache korrekt eingestellt + Silbentrennung aktiviert ist), z.B.:

Zwischena., ™ Schriftart Absatz Formatvorlagen

[ ein, was-evtl.-(bei-unterschiedlichen-Format-Voreinstellungen-in-der-normal.dot-und-der-urs-
prunglichen-Vorlage)-zu-Anderungen-in-der-Formatierung-fihren-kénnte |

1

e Cursor/Einfugemarke wird gelegentlich an der falschen Stelle angezeigt, so dass Eingaben
nicht an der erwarteten Stelle erscheinen (v.a. innerhalb von Tabellenzellen); Fehler lasst sich
im konkreten Fall durch Wechsel mit Alt+Tab in eine andere Anwendung + wieder zurtick
beheben - anschlielRend wird der Cursor wieder an der korrekten Stelle angezeigt

e Outlook:
div. Fehler + Probleme beim Einrichten eigener Tastaturkiirzel im Mail-Editor, z.B.
Strg+Umschalt+"r" fur "Format>Absatz" funktioniert nicht (ohne Wirkung), wird stattdessen
Strg+Umschalt+"d" verwendet, erscheint eine Outlook-Fehlermeldung "Anruf kann nicht
vermittelt werden" (offensichtlich Tastaturkirzel bereits anders belegt, dies wird jedoch im
Dialogfeld "Tastatur anpassen™ nicht angezeigt)
bei Strg+Umschalt+"j" wird stattdessen die (urspringlich) zugewiesene Funktion
"AnordnenAbsatz" aufgerufen

17.Vergleich PDE-Erstellung mit Adobe Elements 7 und mit MS-AddIn / "Speichern
als PDF"

e Beispieldatei (Word-Dok. mit 860 KB) wurde bei Adobe ca. 490 KB grof3, bei MS mit Option
"Optimieren fur: 'Standard’ " ca. 730 KB grof3, mit Option "Optimieren fiir Mindestgré3e"” ca.
330 KB (hier allerdings enthaltene Grafiken mit Text schlecht lesbar)

e bei MS-PDF-Datei funktionieren auch Links eines Inhaltsverzeichnisses (Hyperlinks auf
benutzerdefinierte Uberschriften), bei Adobe NICHT

e bei MS-AddIn auch PDF/A-Format (ISO 19005-1) méglich

18.Eingabehilfen / Bedienung

ﬂ::n = T
il

Haome Insert Page Lay 3 References Mailings Review View
. I =
y  calibri Body) 11 - A AT B |32 - 1= - S| |2 £E| (8] || 9T |
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Clipboard ™ Font [ Paragraph I
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e Multifunktionsleiste ("Ribbon"), bestehend aus 3 Bereichen: Registerkarten (1), Gruppen (2)
und Befehle/Symbole (3); enthalt die im aktuellen Kontext wichtigen Befehle/Symbole

¢ je nach Bildschirmauflésung, FenstergroRRe, u.a. werden mehr oder weniger Symbole im
Ribbon angezeigt, die restlichen Symbole sind Uber den Dropdown-Pfeil erreichbar (Schalt-
flache Einblenden/Ausblenden - im 0.g. Screenshot z.B. unter dem Paste-Symbol)



Office-2007-Info.doc / Quelle: www.admini.de / Stand: 06.10.2007

Uber die Schaltflache =1 neben dem Gruppennamen lasst sich das aus alten Word-Versionen
bekannte Dialogfeld (z.B. Format > Zeichen) aufrufen

Office-Schaltflache (1) enthalt viele Funktionen des alten "Datei-" Menus:

Do) [d9 -0 2
9/

Home Insert Page |

Uber dem Register "Start" ( b z w.  Adbdfindetsith die "Symbolleiste fir den Schnellzugriff"
(2) - hier kann der Benutzer selber beliebige Symbole hinzufiigen (via Kontextmentfunktion
eines beliebigen Symbols)

Rechtsklick auf Text ==> neben Kontextmeni wird auch eine Formatierungs-Symbolleiste
("Minisymbolleiste fir die Auswahl"; abschaltbar) eingeblendet (aber ohne Quickinfos);
Kontextmeni selbst fast unverandert

je nach Markierung/Kontext erscheint u.U. in der Titelleiste neben "Microsoft Word" eine rote

Schaltflache, mit der weitere Register/Symbole im Ribbon zur Verfiigung gestellt werden.

Beispiel: Grafik markieren ==> Mausklick auf Schaltflache "Bildtools" in der Titelleiste
[Kompatibilitatsmodus] - Microsoft Word Bildtools

Sendungen Uberprufen Ansicht Add-Ins Format

i ) j = Ausrichten ~
|

B

Zuschneiden

A : - M) Tetumbruch ~ %A Drehen ~
Anordnen Schrif

Suche nach einer aus Office 2003 (Word, Excel, PowerPoint) bekannten Funktion unter
Office 2007:
Visuelles interaktives Referenzhandbuch (Online-Hilfe) - simuliert Office 2003 + zeigt dann fur
die wichtigsten Funktionen an, wo die aufgerufene Funktion unter 2007 zu finden ist!
http://office.microsoft.com/de-de/word/HA100744321031.aspx?pid=CH100487431031
Englische Version:
http://office.microsoft.com/en-us/word/HA100744321033.aspx?pid=CH100487431033

AuRerdem stellt Microsoft zum gleichen Zweck (noch vollstandigere) Tabellen fir Word, Excel

und Powerpoint zur Verfigung:
Word:
http://office.microsoft.com/search/redir.aspx?AssetID=AM101938681031&CTT=5&0rigin=HA100625841031
Excel:
http://office.microsoft.com/search/redir.aspx?AssetlD=HA100860481031&CTT=5&0rigin=HA101491511031
Powerpoint:
http://office.microsoft.com/search/redir.aspx?AssetID=HA100666231031&CTT=5&0rigin=HA101490761031

benutzerdefinierte oder aus Addins / Globalen Vorlagen stammende Menls werden jetzt unter
der Registerkarte "AddIns" angezeigt

19.Schwer auffindbare Funktionen (Word)

Kommentar l6schen (unter "Einfliigen")
Inhalte einfugen (unter "Start" / kleiner Dropdown-Pfeil unter "Einfigen")

Alle gedffneten Dokumente schlieRen/speichern: ??? (2003: Shift driicken + MenUl "Datei" >
Alle schlie3en bzw. Alle speichern)

Pfeil-lcon aus der Zeichnen-Symbolleiste unter 2003: ???
- z.B. zum Markieren von mehreren Zeichnungselementen gleichzeitig (unter Start >
Bearbeiten > Markieren > Objekte markieren)

div. Funktionen, die unter 2003 nicht direkt sondern nur indirekt (z.B. Gber eine Schaltflache in
einem Dialogfeld heraus) aufrufbar waren, z.B. Extras > Makros > Makros > Organisieren


http://office.microsoft.com/de-de/word/HA100744321031.aspx?pid=CH100487431031
http://office.microsoft.com/en-us/word/HA100744321033.aspx?pid=CH100487431033
http://office.microsoft.com/search/redir.aspx?AssetID=AM101938681031&CTT=5&Origin=HA100625841031
http://office.microsoft.com/search/redir.aspx?AssetID=HA100860481031&CTT=5&Origin=HA101491511031
http://office.microsoft.com/search/redir.aspx?AssetID=HA100666231031&CTT=5&Origin=HA101490761031

Office-2007-Info.doc / Quelle: www.admini.de / Stand: 06.10.2007

20.Schwer auffindbare Funktionen (Outlook-Editor)

Ruckgangig / Wiederherstellen / Wiederholen (bisher nicht gefunden, nur tiber

Schnellzugriffsleiste)

Farbe "Blau" zur Schnellzugriffsleiste hinzufiigen?

21.Tastaturkirzel

Alt-Taste driicken ==> "Zugriffstasteninfos" (engl. "KeyTips") werden angezeigt (fir jedes

Ribbon-Element bzw. Registerkarte)

div. Tastaturkirzel aus Office 2003 funktionieren unverandert - selbst der Aufruf
unterstrichener Buchstaben aus dem alten Office 2003-Menu funktioniert noch, z.B. "Alt + t; a"
= Format > Absatz! (z.T. aber auch geénderte Buchstaben, z.B. Alt +t; s fir "Format >

Schriftart" statt bisher Format > Zeichen)

Word-2003-Tastaturklrzel, die nicht mehr funktionieren:

Funktion Office 2003 stattdessen unter Office 2007
Word: Zeichenformatierung Atl +t, z (Zei- Atl + t, s (Schriftart)
chen) oder:
Strg +d
Word: Nummerierung + Aufzahlung | Atl +t, n nur bedingt: Alt +r, n

(sinnvoll: Icon in Schnellzugriff-
leiste hinzufligen)

Word: Alle getffneten Dok. schlie- | Alt+Shift+d, ¢ ?7??

Ben

Excel: Einfigen einer ausgeschnit- | Strg + "+" Strg + "+"
tenen Zeile/Spalte (bei aktivem Filter | dito.

oder ausgeblen-
deten Zellen erst
maglich, wenn
eine Zeile/Spalte
markiert ist)

bei einigen Funktionen (z.B. Strg + Shift + s = Formatvorlage zuweisen) erscheint ein kleines

Auswahl fenster

(ehemaliger

nur Uber die Maus geschlossen werden kann

22.Sonstige Infos zu MS Office

Bedeutung der "Gliederungsebene” (siehe Format > Absatz) unter Word 2003/2007:

- wird von div. Funktionen / Icons in der Gliederungsansicht ausgewertet
beim Scrollen Uber die Bildlaufleiste wird immer ein bestimmter Text als Quickinfo
(Sprechblasen-Hilfe) angezeigt, der die Navigation im Dokument erleichtern soll; falls im
Dokument tiberhaupt keine Gliederungsebenen verwendet werden (= nur
Gliederungsebene "Textkdrper"), wird nur "Seite 1" usw. angezeigt; andernfalls wird
zusatzlich noch der Text des nachsten Absatzes mit Gliederungsebene "Ebenel” etc.
angezeigt (z.B. Kapiteliberschriften, wenn diese mit den internen Formatvorlagen

"Uberschrift1" usw. formatiert sind):

ARV {Agswabl sichtbar blebt ¢ h fi )
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Unterschiede zwischen internen Formatvorlagen "Uberschrift1" bis "Uberschrift5" und anderen
Formatvorlagen (z.B. selbstdefinierten Uberschrifts- Formatvorlagen):
ist Voraussetzung fiir den Sprung zur nachsten Uberschrift (Bearbeiten > GeheZu >
Uberschrift); funktioniert nicht bei selbstdefinierten Formatvorlagen, selbst wenn diesen als
Gliederungsebene "Ebenel" etc. zugewiesen wurde
interne Uberschrifts-FV lassen sich nicht I6schen oder liberschreiben

Tabellenzeile markieren + Strg+c + 2x Strg+v ==> aus 1 Tabelle werden 2 Tabellen!?
Normalansicht heil3t jetzt "Entwurf-" Ansicht

Office-Diagnose zur Behebung von Problemen (Aufruf Gber Office-Symbol > Word-Optionen >
Ressourcen oder Uber Startmeni > Programme > Microsoft Office > Microsoft Office Tools >
Microsoft Office Diagnose bzw. tUber C:\Programme\Gemeinsame Dateien\Microsoft
Shared\Office12\offdiag.exe)
--> Test sehr langwierig (ca. 15 Min.), Ergebnis:

Diagnosen, die Probleme identifiziert haben: 1

Diagnosen, die korrigierend eingegriffen haben: 1
(Hintergrinde / Details unklar / It. XML-Logdatei wurde die scp32.dll repariert, dies aber ohne
lok. Admin-Rechte!?)

U Details zur Office-Diagnose siehe http://office.microsoft.com/de-

de/help/HA012340761031.aspx

Excel: Unverandert keine Maglichkeit, 2 gleichnamige Dateien gleichzeitig zu bearbeiten
(Fehlermeldung beim Offnen der 2. Datei; unter Word dagegen problemlos mdglich)

Word: leicht geanderte Darstellung von Texten, z.B. Leerzeichen etwas gréRer dargestellt
(Abstand zwischen Wartern) = besser lesbar

(lasst sich ggf. durch Aktivieren der Option "Zeichenpositionierung fur Layout anstatt fur
Lesbarkeit optimieren" andern; Default: Off)

Ribbon ignoriert unter Windows / Systemsteuerung eingestellte Schriftgrof3e, Fettdruck u.a.

bei div. Optionen ist jetzt besser zu erkennen, ob die Option sich auf die aktuelle Datei oder
den angemeldeten Benutzer (= alle Dateien) bezieht

AutoKorrektur "mfg" funktioniert nicht mehr

regelmafiig Absturz bei Kalender-Export in Windows-Textdatei (Tab-getrennt); unter OL 2003
i.0.

ClearType = ? (identisch mit entspr. XP-Option, nicht unter Vista)



